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RESUMO 

 

MENSURAÇÃO DA DEGRADAÇÃO DE FACHADAS EM ARGAMASSA 

EMPREGANDO A INSPEÇÃO DE EDIFÍCIOS 

 

Autor: Mariana Sarnícola P. H. de Macêdo 

Orientador: Elton Bauer 

Brasília, dezembro de 2017 

 

As fachadas atuam protegendo o edifício e, por esta razão, recebem maior influência dos 

agentes de degradação, tais como radiação solar e chuva dirigida. O estudo desta degradação 

contribui para a escolha mais adequada de soluções construtivas e de materiais, bem como para 

a prevenção e reparo de patologias. Com este intuito, propõe-se a identificação e análise da 

ocorrência de anomalias em fachadas em argamassa por meio do estudo de caso de três edifícios 

situados em Brasília, visando a obtenção de padrões e tendências de degradação. Inicialmente, 

foram selecionadas as patologias mais relevantes para fachadas em argamassa; são elas: 

fissuras, manchas, falhas nas pinturas (bolhas, fissura e descolamento), pulverulência, 

descolamento e eflorescência. A metodologia empregada consiste na inspeção de edifícios e 

utilização de fotografias para a construção de panoramas ortogonalizados para mapeamento e 

quantificação das áreas degradadas. A análise dos dados baseia-se no fator de danos (FD), 

calculado como a soma das áreas afetadas por cada anomalia estudada em relação ao tamanho 

da amostra. Analisou-se a distribuição do FD das amostras e a influência da orientação cardeal 

e da região da fachada na ocorrência de patologias. Foi identificado que manchas e fissuras são 

as falhas mais recorrentes nas fachadas em argamassa, sobretudo na região de topo. E que a 

distribuição do FD tem tendência central, revelando ser a média um valor expressivo de 

comparação.  Observou-se, também, que a degradação de fachadas no oeste é superior a do 

leste, o que vai ao encontro dos padrões de incidência de radiação solar e chuva dirigida 

observados em Brasília. 

 

 

Palavras-chave: Fachada em argamassa, Degradação, Desempenho, Patologia.  

 



  

ABSTRACT 

 

DEGRADATION MENSUREMENT OF MORTAR FAÇADES USING 

BUILDING INSPECTION 

 

Author: Mariana Sarnícola P. H. de Macêdo 

Supervisor: Elton Bauer 

Brasília, December 2017 

 

The façades act to protect the building and, for this reason, they receive the greatest influence 

of the degradation agents, such as solar radiation and wind-driven rain. The study of this 

degradation contributes to a more appropriate choice of constructive solutions and of materials, 

as well as for the prevention and repair of pathologies. With this purpose, this research proposes 

the identification and analysis of the occurrence of anomalies in mortar façades by means of a 

case study of three buildings located in Brasilia, aiming to obtain degradation patterns and 

tendencies. Initially, the most relevant pathologies for mortar façades were selected; they are: 

cracking, staining, paint faults (blister, cissing and sagging), pulverulence, detachment and 

efflorescence. The methodology used is the inspection of buildings and the use of photographs 

for the construction of orthogonalized panoramas for mapping and quantification of degraded 

areas. Data analysis is based on the damage factor (FD), calculated as the sum of the areas 

affected by each anomaly studied in relation to the sample size. The distribution of the samples’ 

FD and the influence of the cardinal orientation and the region of the façade in the occurrence 

of pathologies were analyzed. It was identified that staining and cracking are the most recurrent 

failures in mortar façades, especially in the top region. And that  the distribution of FD has a 

central tendency, revealing that the average is an expressive value of comparison. It was also 

observed that the degradation of façades in the West is superior to that of the East, which is in 

accordance with the patterns of solar radiation and wind-driven rain observed in Brasilia. 

 

 

Key words: Mortar facade, Degradation, Performance, Pathology. 
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1. INTRODUÇÃO 

 

Ao se deparar com um edifício, a primeira impressão que se tem é com base na fachada. Ela 

pode expressar simplicidade ou luxo, bem como o cuidado com a edificação, isto é, se é 

realizada manutenção, além da própria qualidade como um todo (SOUSA et al., 2016). 

 

Assim, a fachada é um dos elementos de maior peso estético. Entretanto, é o mais afetado pela 

ação de agentes de degradação, que contribuem para a redução do desempenho de suas funções 

ao longo de sua vida útil. Este desempenho se reflete não só na estética, mas na satisfação de 

exigências construtivas essenciais de estabilidade mecânica, estanqueidade, conforto e 

economia (SOUSA et al., 2016). 

 

A fachada faz parte da envoltória do edifício e atua na separação e filtragem entre os meios 

exterior e interior, protegendo seus usuários e os elementos estruturais e de alvenaria da ação 

de agentes climáticos - sobretudo chuvas e incidência solar.  Cumpre também a função de 

regulação e ajuste - que abrange os requisitos de conforto térmico, iluminação e ventilação. 

(ISO 6241, 1984; ABNT NBR 15575, 2013).  

 

Segundo Sousa et al. (2016), além da localização do edifício, que implica em diferentes 

condições exteriores (ambiente direto, microclima e atividades vizinhas), interferem na 

degradação das fachadas os seus constituintes e soluções de design (por exemplo: varandas, 

grandes vãos e brises) e materiais (concreto, pedra, tijolos, madeira, metal e plástico). 

 

A grande variedade de materiais, modelos de fachadas e do meio em que podem ser inseridas 

torna complexa a análise de sua degradação. Entretanto, o conhecimento resultante de estudos 

de caso a respeito do desempenho do edifício e seus sistemas e materiais é muito importante 

pois contribui para melhorar o design e a performance futura (PORTEOUS, 2013). 

 

Nesse contexto, tendo em vista a importância do desempenho de fachadas para a qualidade de 

todo o sistema de edificação, torna-se oportuno o estudo da degradação nesses sistemas. Tem 

grande utilidade prática, revelando padrões e tendências de degradação que fornecem subsídios 

para a prevenção e reparo de patologias. 
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Dentro do tema, várias pesquisas foram feitas pelo Programa de Pós-Graduação em Estruturas 

e Construção Civil da Universidade de Brasília (PECC/UnB) e aplicadas ao cenário de Brasília, 

algumas das quais consistem em referências para este trabalho: 

 

• ANTUNES (2010) – Estudo de Manifestações Patológicas em Revestimentos de 

Fachadas – Sistematização da Incidência de Casos. 

 

• SILVA (2014) – Avaliação quantitativa da degradação e vida útil de revestimentos de 

fachada – Aplicação ao caso de Brasília/DF. 

 

• SOUZA (2016) – Evolução da degradação de fachadas – Efeito dos agentes de 

degradação e dos elementos constituintes. 

 

• SANTOS (2017) – Catalogação de patologias em fachadas de edifícios residenciais de 

Brasília.  

 

Diferentemente dos trabalhos citados, a grande maioria com foco em revestimentos cerâmicos, 

este estudo analisa fachadas com acabamento em reboco e pintura. Outro diferencial da 

pesquisa é a introdução de fotografias para a realização do mapeamento e quantificação das 

patologias. 

 

O cenário escolhido foi Brasília, já que a cidade possui grande quantidade de edifícios com 

mesma tipologia construtiva e fachadas com acabamento em reboco e pintura, cerâmico ou 

misto. A relativa homogeneidade das construções permite a identificação das patologias mais 

frequentes e análise de potenciais fatores que podem ter influência sobre a ocorrência das 

mesmas, tais como orientação cardeal, região da fachada (topo, sacadas, etc.), desvinculando 

os resultados das especificidades de cada edifício.  
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1.1 OBJETIVOS 

 

1.1.1 Objetivo Geral 

 

O objetivo desta pesquisa é realizar a análise sistemática da degradação de fachadas em 

argamassa de edifícios em Brasília para a formulação de hipóteses quanto aos fatores que 

afetam a degradação nesses sistemas, por meio da identificação das patologias e análise da 

distribuição do fator de danos (FD). 

 

1.1.2 Objetivos Específicos 

 

• Identificar as patologias mais recorrentes e significativas no estudo de fachadas em 

argamassa, de forma a estabelecer um ponto de partida e orientar o método de análise 

sistemática da degradação. 

 

• Quantificar as áreas afetadas por patologias nas amostras com base no fator de danos 

(FD), visando mensurar a degradação do edifício. 

 

• Analisar a distribuição do FD nas amostras para verificar se a média é um valor 

representativo para comparação e a forma como as patologias se manifestam. 

 

• Analisar a influência da orientação cardeal e da região da fachada nos padrões de 

degradação. 
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2. REVISÃO BIBLIOGRÁFICA 

 

2.1 DESEMPENHO E VIDA ÚTIL DAS FACHADAS 

 

A NBR 15575-1 (ABNT, 2013), que trata sobre o desempenho dos sistemas de vedação, afirma 

que estes possuem diversas funções além de estética, por exemplo função estrutural, 

estanqueidade à água, isolação térmica e acústica e capacidade de suporte a esforços de uso. 

 

O desempenho é definido pela ISO 6241 (1984) e NBR 15575 (ABNT, 2013) como o 

comportamento em uso da edificação e seus sistemas. Isso significa que devem atender às 

funções para o qual foram projetados, garantindo as exigências do usuário.  

 

A estanqueidade é uma das principais exigências funcionais da fachada, devendo esta impedir 

a infiltração de água da chuva e outras fontes. Deve, também, atender aos limites máximos 

dispostos na NBR 15575-1 (ABNT, 2013) de fissuração, empolamento, manchas e outras falhas 

no edifício, decorrentes de ciclos de exposição ao resfriamento e calor que ocorrem ao longo 

de sua vida útil. 

 

Entretanto, a ação de agentes climáticos tais como chuva, vento e radiação solar, tendem a 

reduzir o desempenho das fachadas ao longo de sua vida útil. Essa redução é mais lenta nas 

idades iniciais do edifício, como pode ser observado na Figura 2.1. Os saltos pontuais são 

resultado de manutenções previstas pelo Manual de Uso, Operação e Manutenção, elevando a 

vida útil de projeto (VUP). (ABNT NBR 15575-1, 2013).  

 

O período de tempo em que um sistema atende aos requisitos mínimos de desempenho para os 

quais foi projetado, atendidas as especificações quanto ao uso, operação e manutenção, é 

denominado vida útil (VU). Esta pode ser entendida como uma composição entre o valor teórico 

VUP, definido na fase de projeto, e a influência das ações da manutenção, utilização, natureza 

e vizinhança. 
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Figura 2.1 - Desempenho ao longo do tempo. Fonte: ABNT NBR 15575-1:2013 

 

A NBR 15575 (ABNT, 2013) estabelece diferentes VUPs para os diversos sistemas do edifício 

com base no efeito das falhas de desempenho; da facilidade de manutenção e reparação em caso 

de falha; e do custo de manutenção e reposição. Recomendando o mínimo de 40 anos para os 

sistemas de vedação externa. 

 

A estimativa da vida útil do edifício pode ser feita com base em inspeção, método de obtenção 

de dados de exposição a longo prazo recomendado pela ISO 15686-2 (2012), que tem a 

vantagem de fornecer a correlação direta entre o estado dos componentes, o ambiente de 

exposição e a utilização do edifício. 

 

Este método, contudo, não afasta a dificuldade na obtenção de dados históricos dos 

componentes, e consequentemente, de distinguir entre erros de projeto e patologias devido à 

degradação, desenvolvidas ao longo da vida útil do edifício. Ademais, o meio ambiente é 

complexo e não pode ser controlado, não sendo, portanto, facilmente medido ou descrito. (ISO 

15686-2, 2012). 
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2.2 DEGRADAÇÃO 

 

A degradação é a perda de desempenho de um edifício e seus sistemas devido à atuação de 

agentes de degradação, fatores que afetam negativamente o desempenho dos componentes e 

materiais do edifício, incluindo aqueles ligados ao clima, biológicos, esforços mecânicos, 

incompatibilidades e fatores de uso. (ISO 6241, 1984; ABNT NBR 15575-1, 2013). 

 

A Tabela 2-1 apresenta os agentes de degradação de acordo com sua natureza, ainda que esta 

possa ser diferente da natureza de suas ações. Um agente térmico, por exemplo, pode tanto ter 

uma ação física, como aquecimento, quanto uma ação química, como a catálise. (ISO 6241, 

1984). 

Tabela 2-1 – Natureza dos agentes de degradação. (ISO 6241:1984) 

Natureza Classe 

Agentes mecânicos 

Gravidade 

Ações e deformações impostas 

Energia cinética 

Vibrações e ruídos 

Agentes Eletromagnéticos 

Radiação 

Eletricidade 

Magnetismo 

Agentes térmicos Calor, gelo, choque térmico 

Agentes químicos 

Águas e solventes 

Oxidantes 

Redutores 

Ácidos 

Bases 

Sais 

Materiais inertes 

Agentes biológicos 
Vegetais e micro-organismos 

Animais 

 

Quanto à origem dos agentes de degradação, estes dividem-se em externos ou internos à 

construção. Os externos podem ser atmosféricos ou relativos ao solo, enquanto os internos são 

consequência da ocupação ou do projeto. (ISO 6241,1984).  
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Sousa et. al (2016) ressalta que agentes de diferentes origens podem ter uma mesma natureza. 

Por exemplo, a água, que é um agente químico, pode ser de origem atmosférica (umidade do 

ar, condensação e precipitações), ou provir do solo (água de superfície ou subterrânea), ou da 

ocupação (condensação, lavagem), e até mesmo de consequências do projeto (distribuição de 

água, águas residuais e infiltrações).  

 

A atuação dos agentes ocorre de forma simultânea e a degradação se apresenta em uma forma 

combinada de causas e efeitos. Por exemplo, em um edifício sujeito diariamente a incidência 

solar e ação do vento, o aparecimento de uma fissura pode facilitar a descolamento de parte da 

argamassa de revestimento, como ocorrido na Figura 2.2. A complexidade resultante da 

combinação de agentes de degradação e anomalias é uma das principais dificuldades no 

diagnóstico das causas da degradação em fachadas (GASPAR, 2009). 

 

 

Figura 2.2 – Fissuração e descolamento em edifício em Brasília. 
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2.3 PATOLOGIAS 

 

Os agentes de degradação e as patologias desenvolvidas mudam em função das características 

construtivas do edifício e de diversos outros fatores, com destaque para a localização. Assim, 

esta seção tratará apenas das anomalias mais relevantes ao estudo em questão: patologias 

desenvolvidas em fachadas com acabamento em reboco e pintura de edifícios em Brasília. 

 

As patologias podem ser divididas em estéticas e funcionais. A primeira categoria engloba as 

que afetam a aparência do edifício, sem apresentar riscos à estabilidade e segurança do mesmo, 

tais como manchamentos. Já as funcionais afetam o desempenho de componentes e sistemas da 

edificação, podendo comprometer, ainda, sua segurança. (GOLDBERG, 1998). 

 

O principal agente de degradação das argamassas depois de endurecida é a água, assim, 

revestimentos adequadamente protegidos contra a umidade tendem a ter uma maior 

durabilidade. (THOMAZ, 1996a apud SEGAT, 2005). 

 

2.3.1 Manchas 

 

Em primeiro momento, as manchas têm caráter superficial, afetando os níveis estéticos apenas, 

por meio de alteração de cor ou brilho. Contudo, sua permanência no revestimento, em conjunto 

com a presença de umidade, pode contribuir para o agravamento de anomalias, promovendo a 

degradação do material de revestimento e perda de suas propriedades. (SANTOS, 2017). 

 

Há vários tipos de manifestações, dentre os principais, Gaspar (2009) cita sujidade, umidade, 

termoferese, origem biológica, corrosão, alterações cromáticas e ação humana, apresentados na  

Figura 2.3.  

 

A mancha por corrosão é, segundo Santos (2017), decorrente do transporte pela água de 

produtos de corrosão de elementos metálicos (óxidos), provindos de armaduras expostas, 

esquadrias, peças metálicas de fixação e outros elementos metálicos presentes na fachada. Na  

Figura 2.3 (corrosão), observa-se que ocorreu a corrosão da grade metálica, e, com a chuva, 

parte desse produto escorreu juntamente com a água e se depositou sobre a fachada. 
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Corrosão Alterações cromáticas Termoferese Origem biológica 

 

 

 

 

Umidade Sujidade Ação humana 

 

  

 

Figura 2.3 – Principais tipos de manchas em fachadas. (Alterações cromáticas, termoferese e origem biológica, 

fonte: Gaspar (2009). 

 

Alterações cromáticas, tais como a da Figura 2.3 (alterações cromáticas), ocorrem devido ao 

desbotamento da pintura em função da ação da chuva e radiação ultravioleta, e estão 

intimamente ligadas à qualidade e tipo de tinta, conforme relata Lambourne (1999).  

 

As manchas classificadas por Gaspar (2009) como de ação humana são as decorrentes de 

vandalismo, mas também de escorrimento de água, proveniente do sistema de drenagem e 

instalações de climatização. Um exemplo é mostrado na Figura 2.3  (ação humana), resultante 

do escorrimento de objetos molhados dispostos sobre a janela. 

 

Gaspar (2009) define a sujidade como a deposição de partículas nas fachadas presentes na 

atmosfera, tais como fuligem e poeira, ou mesmo decorrentes da própria fachada devido à ação 

da chuva; caracterizado por manchas escurecidas como pode ser observado na Figura 2.3 

(sujidade). 

 

Segundo o mesmo autor, a umidade pode ter origens diversas, por exemplo, pode ser decorrente 

da obra, do terreno, de condensações, de precipitação, de fenômenos de higroscopicidade. A 
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permanência de umidade é, inclusive, a principal causa do aparecimento de colonização 

biológica nas fachadas, tais como a apresentada na Figura 2.3  (origem biológica), onde há 

presença de vegetação e na Figura 2.3, onde há mofo. Segat (2005) destaca que a temperatura 

também é um fator condicionante para presença de mofo e bolor, caracterizada por manchas 

escuras em tonalidade preta, marrom e verde. 

 

A termoferese é conhecida como “espectro fantasma” devido à forma como se manifesta, com 

desenho de juntas verticais e horizontais no revestimento, exibida na Figura 2.3 (Termoferese). 

Segat (2005) explica que sua aparência se deve a depósitos diferenciais de poeira na superfície. 

Isto ocorre devido a comportamentos distintos na argamassa com a secagem, em função do 

coeficiente de absorção desigual entre as juntas de assentamento e os componentes de alvenaria. 

Segundo Gaspar (2009), as principais causas desse fenômeno, são a presença de umidade no 

revestimento, sobretudo em situações de ausência ou insuficiência de isolamento térmico, e 

espessura muito pequena do reboco.  

 

2.3.2 Fissuras 

 

As fissuras são aberturas resultantes do alívio de tensões entre partes de um elemento ou entre 

dois elementos que estão em contato. Conforme Santos (2017), essas tensões podem ser 

resultantes de diversas causas, listadas na Tabela 2-2: de natureza estrutural, como a variação 

das condições de apoio; de ações naturais, especialmente devido à movimentações térmicas e 

umidade; e decorrentes do processo de execução ou projeto, por exemplo à ausência de vergas 

e contravergas e de juntas de dilatação. 

 

Em especial em argamassas de revestimento, Bauer (1997) associa a fissuração, quando não 

estrutural, ao processo de execução, solicitações higrotérmicas e retração hidráulica da 

argamassa.   
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Tabela 2-2 – Principais causas de fissuração. (SANTOS, 2017 – modificado) 

Natureza Causa 

Estruturais 
Deformação 

Variação das condições de apoio 

De ações naturais 

Física (efeitos do vento e da chuva, movimentos térmicos/umidade) 

Química (oxidação, carbonatação, chuva ácida, sais, poluição, etc.) 

Biológica 

Quanto ao processo 

(execução ou projeto) 

Ausência ou subdimensionamento de vergas e contravergas 

Desrespeito entre os tempos de espera entre as camadas do sistema de 

revestimento 

Dosagem ou preparo inadequado da argamassa 

Não detalhamento construtivo 

Concepção/posicionamento/preenchimento deficiente de juntas 

Espessura da camada de revestimento 

Retração 

Excesso de desempeno da argamassa 

Deficiência nas ligações entre os subsistemas e materiais da fachada 

Absorção excessiva do suporte 

 

 

As fissuras podem se manifestar isoladas ou de forma repetitiva, assumindo diferentes formas, 

por exemplo, em malha, linear, composta e reticulada (GASPAR, 2009).  

 

Santos (2017) afirma que um caso típico de fissura linear é o que ocorre no topo de edifícios, 

onde há grande exposição à radiação solar, em função de movimentações térmicas provocadas 

pela dilatação da laje de cobertura. Conforme Gaspar (2009), em geral essas fissuras apresentam 

configuração linear contínua, interrompida ou formando linhas com 30° a 45° com a horizontal, 

paralelas entre si, como pode ser observado na Figura 2.4 (c).  

 

Outro caso muito comum é a fissuração a partir dos vértices inferiores de janelas, mostrado na  

Figura 2.4 (a) e Figura 2.4 (b). Santos (2017) explica que a causa principal é a inexistência ou 

subdimensionamento de vergas e contravergas, de modo que o edifício não consegue absorver 

as movimentações atuantes durante sua vida útil. Os cantos de aberturas são pontos vulneráveis 

à fissuração, pois é onde ocorre maior concentração de tensões.  
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(a) 

 

(b) 

 

(c) 

 

Figura 2.4 – Fissuras próximo a aberturas (acima) e fissura no topo (abaixo). 

 

2.3.3 Descolamento 

 

A separação da argamassa em relação ao seu suporte (Figura 2.5) geralmente ocorre devido ao 

efeito da gravidade e às deformações do material, de modo que algumas regiões não conseguem 

atender aos esforços de flexão e torção que atuam sobre a camada rígida do revestimento 

GASPAR (2009). 

 

O empolamento pode anteceder ao descolamento em si, caracterizado pela deformação de 

regiões da superfície com formação de convexidades para o exterior. Cincotto (1988) aponta 

como principal causa dessa ocorrência a presença de cal parcialmente hidratada na argamassa 

com óxido de magnésio. Quando ocorre a hidratação da cal, a argamassa expande e o 

revestimento empola gradativamente, descolando do emboço de forma localizada.  

 

O descolamento pode ocorrer de forma localizada, como na Figura 2.5 (esquerda) ou também 

em placas, como na Figura 2.5 (direita). Bauer (1997) e Cincotto (1988) apresentam como as 

principais causas do descolamento: 
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• Preparação inadequada da base de concreto; 

• Ausência de chapisco; 

• Chapisco preparado com areia fina; 

• Argamassa com espessura excessiva; 

• Argamassa rica em cimento; 

• Acabamento superficial inadequado de camada intermediária. 

 

Segundo esses autores, o excesso de cimento resulta em um material com pouca elasticidade e 

incapaz de resistir às movimentações da estrutura. Por outro lado, a falta de aglomerante pode 

prejudicar a aderência da argamassa ao substrato. Esta pode ser prejudicada também por falta 

de preparação e limpeza da base, por meio da ausência de chapisco e presença de óleos, agente 

desmoldante, pó e resíduos na superfície. E, por último, o peso próprio de camadas muito 

espessas pode gerar força gravitacional maior que a adesão inicial com o substrato, provocando 

queda do revestimento.  

 

(a) 

 

(b) 

 

Figura 2.5 – Descolamento localizado (a) e em placas (b). (Fonte de (b): LEM - UnB. Arquivo fotográfico). 
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2.3.4 Patologias no sistema de pinturas 

 

Lambourne (1999) afirma que as propriedades mecânicas das películas de pintura são muito 

importantes para a manutenção da função protetora do revestimento. Elas estão sujeitas a 

diversas forças mecânicas de deformação, tais como impacto de pedras e partículas; e a ciclos 

de contração e expansão, em resposta a mudanças na umidade atmosférica e temperatura, que 

levam a deformações irreversíveis e até mesmo fissurações na película de tinta, como observado 

na Figura 2.6.  

 

(a) (b) 

 

Figura 2.6 – Fissuração combinada com descolamento da película de pintura. (Fonte de (a): LEM - UnB. 

Arquivo fotográfico). 

 

Garrido (2010) explica que o ligante da tinta está intimamente relacionado à susceptibilidade 

desta à fissuração. Pinturas com tinta a óleo superfície lisa (sem textura) apresentam fissuração 

típica generalizada do tipo “craquelê” ou “pele de crocodilo”. Isso ocorre porque os óleos 

sicativos são um ligante autoxidável e, ao longo de seu endurecimento, com a ocorrência de 

oxidação e “cross-linking” (formação de ligações químicas unindo cadeias de polímeros), a 

película fica mais quebradiça e sujeita a retração.  

 

Além do ligante, componente responsável pela formação da película seca, há outros fatores que 

influenciam o desempenho dos sistemas de pintura como a aderência ao suporte e a preparação 

da superfície (substrato) para aplicação da pintura (GARRIDO, 2010). 
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Labourne (1999) afirma também que a exposição contínua à condensação de ar e água pode 

levar a lixiviação de componentes de baixo peso molecular, tais como solventes retidos e 

plastificantes. E a exposição a oxigênio no ar e à radiação ultravioleta pode levar a várias 

reações fotolíticas, que podem gerar radicais livres e peróxidos, fragilizando a película.  

 

Além disso, a entrada de água na película combinada com a presença de oxigênio e ânions pode 

levar a formação de bolhas. De fato, na Figura 2.7 (a), pode-se obsevar a formação de bolhas 

em uma região com presença de água, e, na Figura 2.7 (b), a formação de bolhas em situação 

semelhante levou ao descolamento. 

 

 

(a) 

 

(b) 

 

Figura 2.7 – Falhas na pintura do edifício A1 - bolhas no topo (esquerda) e bolhas com descolamento (direita). 

 

O descolamento se manifesta pelo desprendimento local da película de tinta, como pode ser 

observado na Figura 2.7 (b) e ocorre geralmente por perda de aderência entre a película e o 

substrato (UEMOTO, 1988). Este distingue-se do descolamento referido no capítulo anterior, 

que se refere a destacamentos de parte do substrato, ainda que estes possam vir acompanhados 

da remoção de parte da película.  

 

Santos (2017) aponta a presença de umidade em fachadas em argamassa, dada a porosidade 

desta, como uma das principais causas que conduzem ao descolamento da pintura. Segundo 

Cincotto (1983) apud Antunes (2010), esse descolamento pode ocorrer de diferentes formas: 

por meio da perda de aderência da película, pulverulências ou descolamentos com posterior 

perda de aderência e escamação da película. 
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2.3.5 Pulverulência (Desagregação) 

 

A pulverulência geralmente se manifesta, como apontado por Gaspar (2009), pela desagregação 

de vários componentes da argamassa, de forma esfarelada, conduzindo ao desprendimento de 

materiais sob a forma de pó; ou pela perda ou lavagem de partículas finas da argamassa e 

facilidade de desprendimento com pequenos esforços, por exemplo, ao ser pressionada 

manualmente. 

 

A ocorrência desta patologia é condicionada por fatores tais como alta concentração de 

materiais pulverulentos e torrões de argila no agregado (que se expandem em contato com 

umidade, provocando queda do revestimento), traço pobre em aglomerantes ou excessivamente 

rico em cal, e a ausência da completa da carbonatação da cal, decorrente da execução de camada 

muito espessa de reboco ou aplicação prematura de pinturas (BAUER, 1997). 

 

  

 

Figura 2.8 – Pulverulência em fachadas em Brasília. 

 

A desagregação pode se manifestar, também, associada a outras patologias. Por exemplo, 

posteriormente ao descolamento, como consequência da exposição das camadas mais internas 

do revestimento, geralmente menos rígidas, aos agentes atmosféricos. Ou em decorrência de 

microfissuras na camada de reboco, originárias de aumento diferencial de volume das camadas 

mais superficiais em relação às mais internas, em função da infiltração de umidade nos poros 

da argamassa e dissolução de componentes desta. 
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2.3.6 Eflorescência 

 

As eflorescências são depósitos salinos na superfície de revestimentos, provenientes da 

migração de sais solúveis presentes nos materiais ou componentes de alvenaria. Manifestam-se 

tipicamente pela presença de manchas de umidade e pelo acúmulo de pó branco sobre a 

superfície (BAUER, 1997; CINCOTTO,1988). 

 

Bauer (2007) relata que as eflorescências geralmente ocorrem em fachadas quando estas ficam 

umedecidas por muito tempo, e componentes presentes na argamassa ou tijolos (tais como sais, 

hidróxidos e carbonatos solúveis) dissolvem-se e depositam-se nos poros dos materiais, que 

ficam saturados e são então levados à superfície por difusão e evaporação, formando depósitos 

salinos na superfície. 

 

As eflorescências geralmente alteram a superfície causando danos estéticos apenas, entretanto, 

em determinados casos, seus sais podem ser agressivos, promovendo desagregação, 

principalmente quando há compostos expansivos. Além disso, a manifestação dessa patologia 

é efeito da umidade, que consiste em um problema mais grave e frequente em edificações 

(SEGAT, 2005). 

 

 

Figura 2.9 – Eflorescência em fachadas em Brasília. 

 

A eflorescência depende da ocorrência simultânea de três fatores: teor de sais solúveis, presença 

de água e pressão hidrostática, para  propiciar a migração da solução para a superfície 
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(ANTUNES, 2010, UEMOTO, 1988). Gaspar (2009) explica que a água presente no interior 

dos elementos de construção pode migrar para o exterior transportando sais dissolvidos nestes. 

Conforme a água se aproxima do exterior, ela evapora e os sais se cristalizam.  

 

Quando a cristalização dos sais ocorre no interior do material, é denominada 

criptoeflorescência, sendo esta mais prejudicial à durabilidade do revestimento, pois as tensões 

devido à expansão dos sais podem ocasionar descolamento de parte da camada que os envolve. 

 

3. METODOLOGIA 

 

O passo inicial da pesquisa foi a seleção das principais patologias em fachadas com acabamento 

em reboco e pintura decorrentes do processo de degradação. Realizando, em seguida, análise 

de sua ocorrência e distribuição em três edifícios em Brasília. 

 

3.1 DEFINIÇÃO DAS PATOLOGIAS ESTUDADAS 

 

Como explicado no capítulo 2, o processo de degradação é influenciado por diversos fatores 

devido às condições externas de exposição do edifício (clima, vizinhança etc.), bem como em 

razão das próprias soluções construtivas, tais como elementos, materiais e métodos utilizados. 

Assim, a etapa inicial deste estudo consiste na identificação das patologias relevantes no 

contexto estudado, as quais serão investigadas na etapa de inspeção. 

 

Este trabalho tem como cenário a cidade de Brasília, onde há grande quantidade de edifícios 

com a mesma tipologia construtiva, ambiente apropriado para o estudo dos agentes de 

degradação e de recorrência de anomalias. Foram selecionados edifícios com avançado estágio 

de degradação e com fachadas predominantemente com acabamento final em reboco e pintura.  

 

A degradação em fachadas se manifesta de diversas formas. Foram definidos oito grupos de 

patologias, nos quais se embasará o método de estudo da degradação de fachadas desenvolvido 

no presente trabalho (capítulo 2.3). Os grupos selecionados são apresentados a seguir, 

juntamente com as siglas utilizadas: 
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• Manchas (M); 

• Fissuras (FI); 

• Fissura na pintura (PF); 

• Descolamento da pintura (PD); 

• Bolhas na pintura (PB); 

• Descolamento (D); 

• Pulverulência/desagregação (P); 

• Eflorescência (E). 

 

Apesar das diversas formas de manifestação das manchas em fachadas e causas associadas a 

elas (capítulo 2.3.1), optou-se por caracterizar como manchas, principalmente aquelas 

escurecidas em função da presença de umidade. Em função da elevada degradação do sistema 

de pintura e falta de manutenção na mesma, além da dificuldade de detecção de alterações 

cromáticas por meio de fotografia ou percepção visual, optou-se por não considerar tais 

anomalias no estudo. 

 

As fissuras detectadas são as visíveis no período do dia em que foi realizada a inspeção. 

Destaca-se que as vistorias foram realizadas de manhã e à tarde, na presença de luz solar e 

elevadas temperaturas.  

 

3.2 MÉTODO DE AVALIAÇÃO DA DEGRADAÇÃO 

 

Este capítulo aborda a metodologia de pesquisa, desde a obtenção de dados ao cálculo do FD,  

aplicada no estudo da degradação da fachada em argamassa de três edifícios em Brasília. O 

método é baseado na inspeção de edifícios e utilização de fotografias para a construção de 

panoramas ortogonalizados para mapeamento e quantificação das áreas degradadas, e pode ser 

dividido nas seguintes etapas: 

 

• Investigação documental; 

• Investigação de campo; 

• Divisão em amostras; 

• Mapeamento das patologias; 

• Quantificação das patologias; 
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• Cálculo do FD. 

 

3.2.1 Investigação documental 

 

Antes da inspeção em campo deve-se recolher as informações relevantes sobre o edifício, como 

o ano de ocupação, e materiais auxiliares como a planta do projeto executivo. Na inexistência 

deste, propõe-se a realização de medidas no local para a elaboração de croqui do prédio como 

instrumento auxiliar para a inspeção de campo, o qual será utilizado também na quantificação 

das áreas degradadas.  

 

Além disso, é importante a coleta de informações a respeito do histórico do edifício. Assim, 

recomenda-se conversar com porteiros, moradores, e utilizar de livros de registros de modo a 

verificar as datas de realização de manutenções (caso tenham sido feitas), eventos relacionados 

com o aparecimento de patologias, reclamações.  

 

3.2.2 Investigação de campo 

 

A investigação de campo inclui vistoria e inspeção, esta sob olhar mais técnico, e registro 

fotográfico. Além da percepção visual acerca dos problemas, pode-se utilizar diversas 

ferramentas e técnicas para uma análise mais aprofundada.  

 

No caso das fachadas, torna-se relevante a utilização de técnicas não destrutivas, que possam 

ser realizadas à grandes distâncias de modo eficiente. Dentre os possíveis métodos, pode-se 

citar a termografia infravermelha, que, com base na diferença de temperatura entre as regiões 

da fachada, permite a delimitação de fissuras e regiões de umidade, e identificação de 

heterogeneidades superficiais. (BAUER e PAVÓN, 2015) 

 

3.2.3 Divisão em amostras 

 

Foram escolhidos edifícios residenciais com fachadas predominantemente em argamassa, de 

modo a obter amostras significantes para o estudo.  
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Inicialmente, deve-se dividir o edifício em prumadas (lados mais extensos do edifício, que 

abrangem a fachada principal) e empenas (laterais do edifício), e identificar a orientação 

correspondente. Esta foi realizada com base no azimute em quatro faixas de orientação (Figura 

3.1), conforme sugestão de Silva (2014): 

 

• Faixa de orientação Norte compreendida entre os azimutes 315° e 44°. (em azul). 

• Faixa de orientação Leste compreendida entre os azimutes 45° e 134° (em amarelo); 

• Faixa de orientação Sul compreendida entre os azimutes 135° e 224° (em verde); 

• Faixa de orientação Oeste compreendida entre os azimutes 225° e 314° (em laranja); 

 

 

Figura 3.1 - Amplitude dos quadrantes Norte (N), Leste (L), Sul (S) e Oeste (O) para classificação da orientação 

das amostras de fachadas. SILVA (2014) 

 

Cada edifício foi dividido em amostras, cada uma com uma área representativa para o estudo 

quanto ao tamanho e homogeneidade. Os limites devem ser fixados em áreas que apresentam 

descontinuidades, tais como juntas de dilatação ou mudança de orientação.  

 

Além disso, secciona-se o edifício preferencialmente em trechos de acordo com o plano em que 

se encontram, de forma que as áreas mais externas se encontrem em amostras distintas das mais 

internas, que, usualmente menores, podem contemplar também as reentrâncias (paredes laterais 

que conectam os trechos em diferentes planos). Destaca-se que devem ser desconsiderados 

trechos com revestimento cerâmico ou outros materiais que não em argamassa (Figura 3.2). 
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Figura 3.2 – Representação de trecho da prumada leste do edifício A1 dividido em amostras. Cada cor 

representa uma amostra, e as áreas com “X” foram desconsideradas pois apresentam acabamento cerâmico. 

 

O nome de identificação da amostra é composto por três partes separadas por pontos. A primeira 

refere-se ao número de identificação do edifício, contado sequencialmente de acordo com a 

data de inspeção. A segunda informa se a amostra é uma prumada ou uma empena e revela sua 

orientação. E a terceira fornece o número sequencial da amostra, cuja contagem é reiniciada a 

cada prumada ou empena, e se dá a partir da esquerda para a direita. Por exemplo, a amostra 

A1.PO.1 pertence ao edifício A1, mais especificamente à prumada oeste, e consiste na primeira 

amostra desde a esquerda. 

 

3.2.4 Mapeamento das patologias 

 

O mapeamento consiste na identificação e contagem das áreas afetadas por anomalias com base 

nas fotografias e croquis das amostras. Portanto, as fotos devem ter resolução suficiente para 

permitir visualização e detalhamento adequado das patologias.  

 

Dentro da pesquisa em questão, a investigação de campo abrangeu a inspeção visual in loco do 

edifício e realização de registro fotográfico das fachadas. A foto inicial deve abranger, se 

possível, toda a fachada para uma orientação, e, em seguida, ser realizada de forma organizada 

e seguindo um padrão, contemplando regiões menores, com resolução e tamanho suficiente 

para a detecção posterior das patologias. Por exemplo, nos edifícios estudados, as fotos 

contemplaram verticalmente dois andares e, horizontalmente, duas linhas de janelas. É 

importante que haja rigor na obtenção das fotografias, e que se procure alinhar o edifício com 

as margens da lente da câmera, de modo a reduzir distorções.  
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As imagens devem ser ortogonalizada para a obtenção de melhores resultados em termos de 

dimensões e forma das patologias e depois sobrepostas ao croqui para montar um conjunto 

(panorama). Como exemplo, um panorama ortogonalizado para o edifício A2 é exibido na 

Figura 3.3. 

 

 

(a) 

 

(b) 

 

Figura 3.3 – Comparação entre uma foto não-ortogonalizada (a) e panorama ortogonalizado (b). 

 

A ortogonalização e composição das fotos pode ser efetuada por meio de diversos softwares, 

pode-se citar o ICE (Image Composite Editor), Hugin e Adobe Photoshop.  Este último foi o 

utilizado neste trabalho, pois apresenta diferentes ferramentas que permitem tal procedimento 
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e não necessita de tanto rigor na qualidade das fotografias. Além disso, por meio do passo a 

passo, descrito no Anexo A, consegue-se atingir o resultado desejado de maneira fácil e rápida. 

 

Primeiramente foi efetuada a ortogonalização das fotos parciais por meio da função 

“Perspective Cut” e, em seguida, a sobreposição das fotografias no croqui do edifício, a fim de 

obter as dimensões reais deste, com ajuda de guias auxiliares (Figura 3.4). Os panoramas 

ortogonalizados das amostras estudadas nesta pesquisa estão apresentados no Anexo B. 

 

 

Figura 3.4 -Passo a passo da composição de fotos e ortogonalização no Adobe Photoshop. 

 

3.2.5 Quantificação das patologias  

 

A quantificação consiste na identificação e contagem das áreas afetadas por patologias com 

base nas fotos e croqui das amostras.  

 

Para a contabilização das áreas degradadas, deve-se primeiro definir as áreas de influência de 

cada anomalia. Isso é feito de modo a facilitar a contagem das áreas degradadas e compatibilizar 

as patologias que se apresentam de forma linear, tais como fissuras. Usa-se, então, o método de 

gradeamento recomendado pelo MMD, que se baseia na sobreposição de uma malha com 

unidades de 0,50m x 0,50m sobre as amostras, como observado na Figura 3.5. Define-se como 

ponto inicial para a inserção da grade o ponto inferior esquerdo da amostra. 
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Figura 3.5 – Sobreposição de malha e divisão em amostras para o edifício A2. 

 

Após colocada a malha, deve-se realizar subdivisão de cada amostra segundo a região da 

fachada em que se manifestam, conforme a Figura 3.6: 

 

• Sacadas (SC) – áreas de paredes de guarda corpo que sobressaem do plano de fachada; 

• Topo (TO) – áreas de platibanda; 

• Aberturas (AB) – áreas em torno das janelas; 

• Transição entre Pavimentos (TP) – áreas entre os andares, a cada pé direito; 

• Cantos e Extremidades (CE) – áreas de contorno do plano de fachada; 

• Paredes Contínuas (PC) – áreas contínuas. 
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Figura 3.6 – Edifício hipotético com malha sobreposta e divisão das unidades em regiões (PINHEIRO, 2016). 

 

Em alguns casos, uma única unidade de malha abrange mais de uma região. No caso de uma 

janela de canto, por exemplo, uma unidade pode apresentar parte de janela e parte de canto, 

podendo ser classificada tanto em AB quanto em CE. De modo a evitar esse conflito e 

padronizar a seleção, segue-se recomendação de Souza (2016), seguindo uma sequência na 

definição das regiões. Primeiro delimitam-se as unidades pertencentes à região de aberturas 

(AB), seguido por sacadas (SC), cantos e extremidades (CE), transição entre pavimentos (TP), 

paredes contínuas (PC) e, por último, topo (TO).  

 

Realizado gradeamento e delimitação das regiões de fachada, procede-se para a quantificação 

das áreas degradadas. Contabilizam-se as unidades de malha afetadas por cada patologia, 

número que multiplicado pela área de cada unidade de malha (0,25 m²) fornece as áreas 

degradadas.  

 

3.2.6 Cálculo do FD 

 

Assim como realizado por Silva (2014) e Souza (2016), as análises tem base no índice 

denominado Fator de Danos (FD), que revela a proporção da área degradada em função do 

tamanho da amostra. 
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O FD é um índice calculado em termos de áreas, relevante numa análise da extensão dos danos 

da fachada (Equação 3.1).    

 

                                                             𝐹𝐷 =
∑𝐴𝑑(𝑛)

𝐴𝑡
                                         (Equação 3.1) 

 

FD: Fator de Dano total da fachada; 

Ad: Área danificada de determinada anomalia (n), calculada na fase de mapeamento; 

At: Área total da amostra. 

 

Ele pode ser calculado tanto em termos da área danificada de uma determinada patologia, 

quanto em termos da área total danificada, englobando todos os tipos de danos. Destaca-se que 

a área anômala total pode ser, teoricamente, maior que a área da amostra da fachada, tendo em 

vista que em uma mesma unidade podem existir mais de um tipo de patologia e cada uma é 

contabilizada separadamente.  

 

Calculado o FD, há vários tipos de análises que podem ser realizadas: 

 

• Ocorrência relativa entre as patologias; 

• Influência da orientação cardeal; 

• Influência da altura (andar); 

• Influência na região da fachada em que ocorre. 

 

4. RESULTADOS 

 

Este capítulo apresenta os resultados das análises da ocorrência e distribuição do FD, realizada 

com base em gráficos de setores e histogramas, e está divido em: 

 

• Identificação dos edifícios e resultados iniciais - onde é realizada abordagem individual 

de cada edifício, em termos das patologias mais frequentes, distribuição dos FD parciais 

e total. 
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• Análise da patologia por região – a partir dos dados de todos os edifícios são formuladas 

hipóteses quanto à influência das orientações na ocorrência das patologias, em especial, 

comparando leste e oeste. 

 

• Análise das patologias por região – também a partir de todo o conjunto de dados, é 

mostrada a relação entre a ocorrência das patologias e as regiões analisadas. 

 

• Resultados gerais – é realizada a comparação entre os resultados dos três edifícios e 

apresentado panorama geral da ocorrência e distribuição das patologias nas fachadas. 

 

4.1 IDENTIFICAÇÃO DOS EDIFÍCIOS E RESULTADOS INICIAIS 

 

Os três edifícios estudados localizam-se em Brasília, no bairro Asa Norte. A planta aérea obtida 

do Google Earth (Figura 4.1) mostra a localização relativa entre eles. Como pode ser observado, 

todos os edifícios possuem as empenas voltadas para norte e sul e prumadas para leste e oeste. 

Os edifícios A1 e A2 possuem fachada principal com orientação para o leste e o A3, para o 

oeste.  

 

 

Figura 4.1 – Localização e orientação dos edifícios A1, A2 e A3. 
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4.1.1  Edifício A1 

 

O primeiro edifício inspecionado foi identificado como A1, a fachada é revestida 

predominantemente com acabamento em reboco e pintura, contendo também varandas em 

revestimento cerâmico, como pode ser observado na Figura 4.2. A prumada principal, que dá 

acesso ao estacionamento aberto, possui orientação leste e situa-se paralelamente à avenida 

“eixo W”, como pode ser observado na Figura 4.1. O edifício é simétrico nos dois eixos (as 

duas prumadas e as duas empenas são iguais entre si) e extenso em comparação com os outros 

edifícios da quadra, sendo composto por três módulos semelhantes ao apresentado na Figura 

4.2, e com varandas nas duas extremidades. 

 

Edifício A1  

Tipo de edificação: Residencial; 

Número de pavimentos: 6 pavimentos tipo;  

Acabamento de fachada: reboco e pintura (predominante) e cerâmico nas varandas;  

Número de amostras: 58 (2 em empenas e 56 em prumadas). 

 

     

                  (a)                                                                                        (b) 

Figura 4.2 – Fotos da prumada leste (a) e empena norte (b). 

 

A partir da quantificação das patologias, construiu-se o gráfico de setores com base no FD 

(Figura 4.3). Todos os tipos de anomalias investigados nesta pesquisa foram encontrados no 

edifício. Fissuras e manchas foram os problemas mais frequentes, contribuindo juntos com 82% 
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das patologias encontradas. Falhas na pintura também apresentaram ocorrência significativa 

(13%), com predominância de descolamento da película. 

 

 

Figura 4.3 – Patologias presentes no edifício A1.  

 

A Figura 4.4 mostra a ocorrência de patologias de acordo com a orientação cardeal. As 

orientações norte e sul referem-se a empenas, não havendo grande distinção entre os resultados 

obtidos. Em ambos os casos, cerca de 90% das anomalias encontradas foram manchas, enquanto 

que apenas 9% se referem a descolamento. 

 

Diferentemente das empenas, as prumadas apresentaram maior frequência de fissuras que de 

manchas. Na orientação leste, 52% das patologias foram fissuras, 42% manchas e 5% 

problemas nas pinturas. Na oeste, fissuras (38%) e manchas (28%) também foram as patologias 

dominantes, contudo, houve maior ocorrência de outros tipos, representando cerca de um terço 

do total, com destaque para descolamento da pintura (11%).  
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Figura 4.4 – Patologias no edifício A1 por orientação 

 

Os gráficos apresentados na Figura 4.4 não revelam a diferença no total de degradação entre as 

orientações, discussão que será abordada no capítulo 4.2. 

 

A distribuição do FD das patologias do edifício A1 é exibida nos histogramas da Figura 4.5, 

bem como a distribuição do FD total (abrangendo todas as patologias). Os histogramas devem 

ser analisados observando a frequência de ocorrência de um FD não nulo nas amostras (eixo 

y), e os valores de FD calculados (eixo x). Além disso, o valor representado no eixo x, apresenta 

o valor médio do intervalo a que a barra se refere. Por exemplo, no histograma de fissura da 

Figura 4.5, a segunda barra com valor no eixo x de 0,08 representa as amostras com FD entre 

0,05 e 0,11. O mesmo raciocínio vale para as outras barras, de forma que, para fissuras, cada 
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uma das sete barras tem espessura de 0,06. O valor de y ainda para a segunda barra é 20, o que 

significa que 20 amostras apresentaram FD para fissuras entre 0,05 e 0,11. 

 

Figura 4.5 – Histograma do FDtotal – A1 

 

A comparação entre o FDtotal e a Tabela 4-1 indica que a distribuição do FD para o edifício 

A1 possui tendência central em torno da média. Entretanto, este comportamento não se repete 

para as patologias tomadas individualmente. Os problemas na pintura (descolamento, bolha e 

fissura), pulverulência e eflorescência, apresentam distribuição assimétrica à esquerda. 

Manchas, fissuras e descolamento exibem um comportamento intermediário entre os dois 

citados, mas, ainda sim, concentram-se em torno de valores abaixo da média. 

 

Tabela 4-1 – Principais valores estatísticos para o FDtotal – A1 

Patologia Média  Desvio Padrão 

Mancha 0,124 0,087 

Fissura 0,120 0,094 

Fissura na pintura 0,029 0,037 

Descolamento da pintura 0,033 0,061 

Bolhas na pintura 0,029 0,043 

Descolamento 0,010 0,006 

Pulverulência 0,033 0,052 

Eflorescência 0,021 0,019 

FDTotal 0,256 0,189 
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Como observado na  Tabela 4-1, o FDtotal possui média de 0,256 e as amostras se distribuem 

em torno deste valor. Esse valor não corresponde, entretanto, à área real degradada, pois pode 

ocorrer a sobreposição de patologias. Por exemplo, um FD resultaria igualmente em 0,2 se 20% 

da área total se exibisse apenas manchas, ou se apenas 5% apresentasse quatro tipos de 

patologias (manchas, fissuras, descolamento e eflorescência, por exemplo).  

 

 

4.1.2  Edifício A2 

 

Os edifícios identificados como A2 e A3 foram construídos a partir da mesma planta 

arquitetônica e possuem, inclusive, a mesma cor. Os edifícios possuem 6 andares e as prumadas 

possuem três módulos iguais separados por juntas de dilatação. 

 

A Figura 4.6 apresenta a fachada principal do edifício (prumada leste) voltada para um 

estacionamento térreo. Há muitas árvores altas em frente às outras faces da fachada (prumada 

oeste e empenas norte e sul). 

 

Edifício A2 

Tipo de edificação: Residencial; 

Ano de ocupação: 1975; 

Número de pavimentos: 6 pavimentos tipo;  

Acabamento de fachada: reboco e pintura;  

Número de amostras: 66 (6 em empenas e 60 em prumadas). 
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Figura 4.6 – Fachada principal do edifício A2. 

 

Assim como no edifício A1, as patologias mais recorrentes no edifício A2, em termos do FD, 

foram manchas e fissuras. Entretanto, neste caso, a proporção de manchas (60%) foi superior à 

de fissuras (34%), o que pode ser verificado comparando os gráficos da Figura 4.3 e Figura 4.7.  

 

 

Figura 4.7 – Patologias presentes no edifício A2. 
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Proporção semelhante ao mostrado na Figura 4.7 se manteve nas amostras divididas por 

orientação, representadas pelos gráficos da Figura 4.8. Não há grande distinção entre as 

orientações, com exceção das amostras da sul, que apresentaram também significativa 

proporção de descolamento (7%) e pulverulência (11%). 

 

 

Figura 4.8 – Patologias no edifício A2 por orientação 

 

Como pode ser observado na Figura 4.9, a ocorrência de falhas nas pinturas (bolhas, 

descolamento e fissura) e eflorescência foi pouco frequente, correspondendo a menos de 11% 

das amostras.  O descolamento apresentou distribuição fortemente assimétrica à esquerda, já 

pulverulência, manchas e fissuras possuem tendência mais central. A Tabela 4-2 mostra que as 

manchas são as que possuem maior FDmédio (0,226), seguida por fissuras (0,132) e 

descolamento (0,098), sendo estas as principais falhas encontradas no edifício.  
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Figura 4.9 – Histograma do FD para as patologias do edifício A2. 

 

O FDtotal possui tendência central, com elevada concentração de valores em torno da média. 

Cerca de 40% das amostras apresentaram valores entre 0,35 e 0,45, como pode ser observado 

na Figura 4.9. A Tabela 4-2 mostra que o FDtotal obteve elevada média (0,377) e baixo desvio 

padrão (0,133), quando comparado com o edifício A1 (0,256 e 0,189, respectivamente, 

verificado na Tabela 4-1), o que sugere que a degradação é mais uniforme ao longo do edifício 

A2. 

Tabela 4-2 – Principais valores estatísticos para o FDtotal – A2 

Patologia Média  Desvio Padrão 

Mancha 0,226 0,089 

Fissura 0,132 0,091 

Fissura na pintura 0,022 0,011 

Descolamento da pintura 0,016 0,011 

Bolhas na pintura 0,005 0,001 

Descolamento 0,098 0,006 

Pulverulência 0,017 0,017 

Eflorescência 0,013 0,009 

FDTotal 0,377 0,133 
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4.1.3  Edifício A3 

 

O edifício A3 está localizado em frente ao edifício anterior (A2), sendo a fachada principal 

(oeste) voltada para o estacionamento, e a prumada leste e empenas com árvores ao redor. A 

Figura 4.10 apresenta a foto do trecho inicial mais ao norte da prumada oeste, e trecho da 

empena norte. 

 

Edifício A3 

Tipo de edificação: Residencial; 

Ano de ocupação: 1975; 

Número de pavimentos: 6 pavimentos tipo;  

Acabamento de fachada: reboco e pintura; 

Número de amostras: 66 (6 em empenas e 60 em prumadas). 

 

 

Figura 4.10 – Lado norte da prumada oeste – edifício A3. 

 

Semelhantemente ao edifício A2, a patologia mais recorrente foi a mancha (66%), seguida de 

fissura (28%), como pode ser observado na Figura 4.11. Em relação às orientações cardeais, 

mostradas na observou-se diferente comportamento, aferido por meio dos gráficos da Figura 

4.12. Nas fachadas norte e oeste observou-se maior proporção de manchas em relação ao 

edifício total (69% e 74%, respectivamente), enquanto que na oeste, maior proporção de fissuras 
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(40%). Entretanto, a que mais se distinguiu foi a fachada sul, que apresentou grande proporção 

de pulverulência (28%), inclusive maior que a de fissuras (21%). 

 

 

Figura 4.11 – Patologias presentes no edifício A3 

 

 

Figura 4.12 – Patologias no edifício A3 por orientação 
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Como pode ser observado na Figura 4.13, semelhantemente ao edifício A2, o FD para falhas 

nas pinturas em A3 se distribuiu em torno de 0,10 e os problemas nas pinturas foram pouco 

recorrentes. Entretanto, para este edifício, mais amostras apresentaram eflorescência (10), 

comparado com 9 amostras no edifício A1 e 4 no A2. Ainda que este valor seja muito pequeno 

(menor que 0,02 para todas as amostras).  

 

 

Figura 4.13 – Histograma do FD para as patologias do edifício A2. 

 

A Tabela 4-2 mostra que o FDtotal médio é de 0,410, revelando grande degradação ao longo 

do edifício comparado com o A1. Conforme Figura 4.13, a maioria das amostras possui FDtotal 

entre 0,2 e 0,6. 

Tabela 4-3 – Principais valores estatísticos para o FDtotal – A3 

Patologia Média  Desvio Padrão 

Mancha 0,269 0,141 

Fissura 0,116 0,077 

Fissura na pintura 0,010 0,006 

Descolamento da pintura 0,014 0,012 

Bolhas na pintura - - 

Descolamento 0,022 0,024 

Pulverulência 0,032 0,050 

Eflorescência 0,010 0,005 

FDTotal 0,410 0,170 
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4.2 ANÁLISE DAS PATOLOGIAS POR ORIENTAÇÃO 

 

O objetivo desta análise é verificar se há relação entre o grau de degradação e as patologias que 

se manifestam, e a orientação cardeal das fachadas. Esta hipótese baseia-se no fato de que as 

fachadas, de acordo com sua orientação, recebem diferente influência de radiação solar e chuva 

dirigida ao longo do ano, principais agentes climáticos de degradação.  

 

Nascimento (2016), com base nos dados do Typical Meteorological Year (TMY) para Brasília-

DF entre os anos 2000 e 2010, mostra que a orientação norte é a que recebe maior incidência 

de irradiância e chuva dirigida, seguida da leste, oeste e sul, como pode ser observado na Figura 

4.14. 

 

 

Figura 4.14 – Síntese do TMY para Brasília a partir da plataforma WUFI (NASCIMENTO, 2016). 

 

Para análise da influência da orientação cardeal, foram utilizados os dados dos três edifícios 

estudados, totalizando 190 amostras. Em todos os casos, as empenas foram enquadradas nas 

faixas de norte e sul, e as prumadas em leste e oeste. Entretanto, obteve-se grande diferença na 

quantidade total de amostras por orientação, de tal forma que 7 amostras correspondem ao norte, 

7 ao sul, 87 ao leste e 89 ao oeste. Portanto, são mais relevantes os resultados obtidos e 

comparações para as orientações leste e oeste, realizando-se, por esse motivo, análise mais 

detalhada para estas duas orientações. 
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A Figura 4.15 apresenta a distribuição do FDtotal entre as amostras para as quatro orientações 

cardeais. A distribuição para as orientações norte e sul foi mais dispersa, enquanto que para 

leste e oeste mostrou tendência central, o que sugere que a média é um parâmetro significativo 

para caracterização do conjunto de amostras das orientações dessas duas. 

 

 

Figura 4.15 – Histogramas do FD por orientação 

 

Os histogramas da Figura 4.16 e Figura 4.17 apresentam a distribuição dos FDs parciais das 

patologias de todas as amostras e o FDtotal. Para ambos os casos, há uma tendência central na 

distribuição de mancha, fissuras e FDtotal, e assimétrica a esquerda para falhas nas pinturas, 

descolamento, pulverulência e eflorescência.  

 

Em geral, os valores das fachadas oeste são maiores que os da leste, o que pode ser facilmente 

verificado na Tabela 4-4. Com exceção de fissuras, todas as outras patologias apresentam média 

e mediana maior para a região oeste comparado com a leste. Entretanto, a diferença entre os 

valores médios das orientações para fissuras foi muito pequena (0,002).  
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Figura 4.16 – Histogramas para o FD da orientação oeste. 

 

 

Figura 4.17 – Histogramas para o FD da orientação leste. 
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A partir da comparação entre os valores médios de FDtotal da Tabela 4-4, conclui-se que as 

patologias que apresentaram maior diferença entre as orientações leste e oeste foram manchas 

(0,114), seguida por descolamento na pintura (0,028) e pulverulência (0,016). Em termos 

porcentuais da média, essas patologias na fachada oeste superaram em 41%, 66% e 50% 

respectivamente a ocorrência no leste. 

 

Tabela 4-4 – Estatísticas para as orientações leste e oeste. 

Patologia Orientação 

N° de 

amostras 

não 

nulas 

N° de 

amostras 

nulas 

Média 
Desvio 

padrão 
Mínimo Mediana Máximo 

Mancha 
L 85 4 0,164 0,079 0,037 0,157 0,446 

O 76 11 0,279 0,144 0,008 0,293 0,607 

Fissura 
L 88 1 0,134 0,088 0,012 0,111 0,408 

O 84 3 0,114 0,086 0,012 0,086 0,427 

Fissura na 

pintura 

L 8 81 0,017 0,016 0,004 0,012 0,053 

O 17 70 0,029 0,034 0,001 0,016 0,129 

Descolamento da 

pintura 

L 15 74 0,014 0,016 0,003 0,008 0,063 

O 17 70 0,042 0,071 0,001 0,012 0,253 

Bolhas na 

pintura 

L 9 80 0,021 0,036 0,002 0,009 0,116 

O 12 75 0,031 0,047 0,001 0,012 0,161 

Descolamento 
L 36 53 0,014 0,016 0,004 0,008 0,078 

O 37 50 0,018 0,020 0,003 0,011 0,105 

Pulverulência 
L 27 62 0,016 0,012 0,002 0,012 0,044 

O 39 48 0,031 0,038 0,004 0,017 0,172 

Eflorescência 
L 6 83 0,011 0,004 0,006 0,010 0,018 

O 15 72 0,018 0,015 0,004 0,012 0,065 

FDtotal 
L 89 0 0,306 0,124 0,024 0,312 0,657 

O 85 2 0,405 0,208 0,012 0,424 0,855 

 

As médias dos FDtotais também indicaram maior degradação na fachada oeste (0,405) que na 

leste (0,306). Como verificação adicional e mais profunda desse resultado, realizou-se análise 

de variância (ANOVA).  

 



44 

Utilizou-se o Minitab para análise dos dois conjuntos de dados, correspondentes às duas 

orientações. A análise da ANOVA é realizada com base no índice “p”, a obtenção de valores 

menores que 0,05 para este índice indica que os conjuntos de dados são estatisticamente 

diferentes. A Figura 4.18 apresenta o resultado desta análise, para o qual o valor de “p” foi 0,00, 

o que significa os dois conjuntos de dados são diferentes, podendo-se concluir que o FD e, 

portanto, a degradação das fachadas, é maior para a orientação oeste que para a leste. 

 

 

Figura 4.18 – Gráfico da ANOVA para o FDtotal das orientações leste e oeste. 

 

Tais resultados estão de acordo com os observados por Nascimento (2016), que apresentaram 

maior incidência de radiação solar e, sobretudo, de chuva dirigida ao longo do ano para as 

fachadas oeste que para as leste. 

 

Conclui-se, portanto, que a chuva dirigida (por meio da ação da umidade e do vento, que 

contribui com a penetração de água e de substâncias sólidas) e a temperatura (que combinada 

com o efeito da umidade promove fenômenos cíclicos de tração e retração), são fatores 

relevantes no aparecimento de patologias. O que é coerente com a maior degradação nas 

fachadas cuja orientação recebe maior incidência desses dois fatores. 

 

OesteLeste

0,45

0,40

0,35

0,30

0,25

D
a
ta

Teste da ANOVA - Leste e Oeste
95% de confiança para o intervalo da média

The pooled standard deviation was used to calculate the intervals.



45 

4.3 ANÁLISE DAS PATOLOGIAS POR REGIÃO 

 

Esta análise busca identificar se há uma região preferencial da fachada para a manifestação de 

patologias, independente da orientação da fachada. Com base no FD das 190 amostras calculado 

em função da área da região, foi construído o gráfico da Figura 4.19. 

 

 

Figura 4.19 – Gráfico do FD médio por região da fachada. 

 

Observa-se que o topo (TO) é a região com maior grau de degradação, com ocorrência 

principalmente de manchas, em média em 79% da área de cada amostra e de fissuras (22%). As 

demais regiões apresentam FD em torno de 0,20, também com ocorrência predominante de 

manchas e fissuras.  

 

Entretanto, nem todas as patologias possuem topo como região preferencial, como pode ser 

observado na Figura 4.20. A ocorrência no topo é maior que a das outras regiões para manchas 

(59%), fissuras (42%), descolamento na pintura (57%), bolhas na pintura (55%) e desagregação  
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(40%). Já descolamento possui maior ocorrência em aberturas (68%) e eflorescência em parede 

contínua (43%).  

 

Destaca-se que estes são resultados preliminares, uma análise mais profunda da relação entre a 

ocorrência das patologias demandaria também análise da distribuição das amostras e, talvez, 

um método mais elaborado para classificação de cada problema em uma região. Tendo em vista 

que o método de gradeamento utilizado permite que em uma unidade de malha sejam 

identificados elementos de mais de uma região, como explicado no capítulo 3.2.5. Assim, por 

exemplo, no caso em que há uma janela próxima a um canto, uma fissura no canto seria 

classificada como abertura, devido à sequência utilizada de prioridade entre as regiões. 

 

Mancha Fissura Fissura na pintura 
Descolamento da 

pintura 

    

Bolhas na pintura Descolamento Desagregação Eflorescência 

    

 

 

Figura 4.20 – Ocorrência das patologias nas regiões de fachada. 

 

Os resultados apresentados mostram que o topo é a região mais degradada da fachada, com 

diferença significante em relação às outras. Isso está de acordo com o afirmado por Nascimento 
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(2016), que o topo é uma das principais regiões atingidas pela chuva dirigida (uma importante 

fonte de água no edifício). Ademais, a umidade é um fator significante na ocorrência de 

diferentes patologias, como manchas, descolamentos, eflorescência. 

 

A grande ocorrência de fissuração é também explicada por Santos (2017), pois devido à 

condição de exposição da laje de cobertura ao intemperismo, há grande movimentação deste 

elemento. Em especial o revestimento em argamassa, por ser mais poroso, é o que mais 

apresenta desgaste natural com o tempo. Além disso, a fissuração facilita a penetração de água, 

favorecendo a ocorrência de outras patologias, como explicado anteriormente. 

 

Este resultado pode ser comparado, ainda, com os obtidos por Souza (2016), que mostra que a 

degradação nos topos é elevada principalmente para edifícios mais antigos (com idade superior 

a 25 anos), no qual se enquadram os edifícios A2 e A3 desta pesquisa. 

 

4.4 RESULTADOS GERAIS 

 

Este capítulo aborda os resultados referentes ao conjunto dos três edifícios e comparação entre 

estes. Como pode ser observado na Tabela 4-5, o edifício A1 foi o que apresentou menor FD 

médio (0,256) e maior desvio padrão (0,188), o que indica que esse é o edifício com menor grau 

de degradação, mas com maior variabilidade entre as amostras, ou seja, a degradação não ocorre 

de maneira uniforme ao longo do edifício.  

 

Os edifícios A2 e A3 exibiram grau similar de degradação, 0,378 e 0,410 respectivamente. O 

que era esperado, já que possuem mesma idade e mesma planta arquitetônica. Este resultado é 

relevante, pois mostra que as patologias estudadas estão mais relacionadas com o processo de 

degradação do que com falhas executivas individuais de cada edifício. 

 

Tabela 4-5 – Resumo do FD médio para os edifícios A1, A2 e A3. 

Edifício 

N° de 

amostras 

não nulas 

N° de 

amostras 

nulas 

Média 
Desvio 

padrão 
Mínimo Mediana Máximo 

A1 56 2 0,256 0,188 0,012 0,233 0,855 

A2 66 0 0,377 0,133 0,171 0,382 0,767 

A3 66 0 0,410 0,171 0,081 0,422 0,763 
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A Figura 4.21 mostra a comparação entre os valores médios de FD para cada patologia. Os 

edifícios A2 e A3 apresentaram comportamento mais parecido, com maior FD de manchas 

(0,226 e 0,269 respectivamente), seguido por fissuras (0,132 e 0,116). Já o edifício A1, 

manifestou menor ocorrência dos dois problemas, sendo que o FD de fissuras (0,124) foi 

ligeiramente superior ao de manchas (0,120). Este resultado pode ser explicado pela idade 

avançada dos edifícios A2 e A3 (42 anos), a qual, de acordo com a NBR 15575 (ABNT, 2013) 

significaria que as fachadas superaram a vida útil mínima (40 anos) recomendada. 

 

 

Figura 4.21 – Comparação entre os FD médios dos edifícios A1, A2 e A3 para cada patologia. 

 

Ainda com relação à Figura 4.21, pode-se observar que o edifício A1 foi o que manifestou 

maior ocorrência de patologias relacionadas ao sistema de pinturas. E os descolamentos 

observados no edifício A2 se manifestaram em áreas maiores, tendo em vista o elevado FD 

desta anomalia (0,098), apesar da baixa ocorrência (de acordo com a Figura 4.7, apenas 3% das 

patologias encontradas no edifício A2 são relativas a descolamentos). 
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O gráfico de setores referente à Figura 4.22 mostra que 91% da ocorrência de patologias 

corresponde a manchas e fissuras, com pequenas porcentagens para os outros tipos. Entretanto, 

como exibido na Tabela 4-6, há manifestação de todos os tipos em pelo menos 23 amostras. 

 

 

Figura 4.22 – Recorrência das patologias nas 190 amostras. 

 

Tabela 4-6 – Estatísticas para as 190 amostras 

Patologia 

N° de 

amostras 

não nulas 

N° de 

amostras 

nulas 

Média 
Desvio 

padrão 
Mínimo Mediana Máximo 

Mancha 175 15 0,217 0,124 0,008 0,196 0,607 

Fissura 182 8 0,123 0,087 0,012 0,098 0,427 

Fissura na 

pintura 
25 159 0,025 0,030 0,001 0,015 0,129 

Descolamento 

da pintura 
34 153 0,028 0,053 0,001 0,012 0,253 

Bolhas na 

pintura 
23 162 0,025 0,040 0,001 0,012 0,161 

Descolamento 81 109 0,017 0,018 0,003 0,011 0,105 

Pulverulência 75 115 0,028 0,043 0,002 0,012 0,291 

Eflorescência 23 167 0,015 0,013 0,003 0,012 0,065 

FD total 188 2 0,353 0,176 0,012 0,352 0,855 

 

56%33%

1%
2%
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Depreende-se dos histogramas da Tabela 4-6 e da Figura 4.23 que, dada a tendência central e 

baixo desvio padrão dos FDs parciais de manchas e fissuras e, principalmente, do FDtotal; a 

média é um indicador confiável que pode ser tomado como base para análises e comparações. 

O mesmo não pode ser estendido para as patologias no sistema de pintura (manchas, fissuras e 

bolhas), descolamento e pulverulência, com tendência assimétrica à esquerda. Para esses, o 

desvio padrão é muito alto, chegando na maioria dos casos a superar o próprio valor da média.  

 

 

Figura 4.23 – Histogramas para todas as patologias das 190 amostras. 

 

Entretanto, o FDtotal apresenta tendência central e aproximadamente normal, sugerindo que a 

média (0,35) é um valor representativo do espaço amostral (conjunto formado pelos edifícios 

A1, A2 e A3).  

 

Comparando com os requisitos dispostos na NBR 15571-1 (ABNT, 2013), quanto ao 

descolamento, as amostras atenderam ao máximo de 5% do pano de fachada tolerado, mas 

superaram a área individual de 0,10 m² recomendada, já que uma unidade da grade utilizada na 

contabilização dos danos equivale a 0,25 m². Entretanto, a norma considera toleráveis apenas 

as falhas não detectáveis a olho nu por um observador a 1m de distância, o que significa que as 

patologias detectadas estão em desacordo com a norma. Conclui-se que os edifícios analisados 
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não atendem aos requisitos mínimos de desempenho e, portanto, chegaram ao fim de sua vida 

útil. Esse resultado era esperado para os edifícios A2 e A3, que de fato superaram os 40 anos 

indicados como vida útil mínima dos sistemas de revestimento. 

 

 

5. CONCLUSÃO 

 

Nesta pesquisa foi analisada a degradação de fachadas em argamassa para três edifícios em 

Brasília com base no fator de danos (FD). Os resultados permitiram a análise da distribuição 

das amostras e da influência da orientação cardeal e das regiões da fachada na ocorrência de 

patologias. As conclusões decorrentes do processo utilizado e resultados obtidos foram: 

 

• A inspeção de edifícios mostrou-se adequada para o estudo da degradação, pois permite 

avaliar o sistema em sua condição real de exposição. 

 

• O método de quantificação das patologias por meio de fotografias também mostrou ser 

adequado, aumentando a precisão na identificação das patologias e definição das áreas 

de influência, em comparação com inspeção visual. 

 

• As patologias selecionadas para o estudo (mancha, fissura, fissura na pintura, bolhas na 

pintura, descolamento da pintura, descolamento, desagregação e eflorescência) foram 

relevantes, tendo em vista que todas apresentaram ocorrência em pelo menos 23 

amostras.   

 

• Manchas e fissuras são as patologias mais frequentes nas fachadas em argamassa e se 

manifestam geralmente em grandes áreas ao longo de todo o edifício. 

 

• A orientação cardeal mostrou grande influência na degradação de fachadas, visto que 

fachadas oestes são mais degradadas que as leste, atribuindo-se a este resultado a ação 

diferenciada dos agentes climáticos (radiação solar e chuva dirigida). 
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• Os topos foram as regiões da fachada mais degradadas, especialmente por manchas, 

devido à elevada exposição à chuva dirigida e radiação solar. Entretanto não foram as 

regiões preferenciais para todos os grupos de patologias. 

 

• A tendência central na distribuição do FD mostrou ser este um indicador importante no 

estudo comparativo entre edifícios e para a representação do grau de degradação das 

fachadas. 

 

 

5.1 SUGESTÕES DE TRABALHOS FUTUROS 

 

• O cálculo do FD é relevante em um primeiro momento, porém deve-se pensar em um 

modo de considerar níveis de gravidade das anomalias, com base no custo de reparo. 

Sugere-se, então, a utilização de índices, tais como o FGD, adotado por Souza (2016), 

mas adaptado às patologias em fachadas em argamassa. 

 

• Como neste trabalho as análises entre as orientações cardeais ficaram limitada a leste e 

oeste, sugere-se a coleta de dados de edifícios com prumada voltada para o norte e sul, 

de modo a obter dados para expandir a análise para estas orientações. 

 

• Sugere-se a realização de análise mais detalhada em função das regiões da fachada e 

elementos construtivos e comparação dos diferentes tipos de revestimentos de modo a 

identificar quais são as soluções mais eficientes. 

 

• Finalmente, o estudo de soluções construtivas voltadas para a região de topo, de modo 

a evitar a ocorrência de patologias, sobretudo manchas e fissuras. 
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ANEXO A TUTORIAL - CONSTRUÇÃO DE PANORAMAS 

ORTOGONALIZADOS 

 

Este tutorial é apresentado como material complementar da monografia “Mensuração da 

degradação de fachadas em argamassa empregando a inspeção de edifícios”, apresentando 

detalhadamente os passos realizados em 3.2.4 (Mapeamento das patologias). 

 

Ensina-se o passo-a-passo da construção de panoramas ortogonalizados no Adobe Photoshop 

CC 2015, desde a passagem do croqui do AutoCAD à obtenção do arquivo em formato JPG. O 

tutorial objetiva facilitar o processo de aprendizado daqueles que desejem realizar 

procedimento semelhante ao apresentado na pesquisa, e organiza-se da seguinte forma: 

 

1. Como passar croqui do AutoCAD para o Photoshop 

2. Como abrir e aumentar o tamanho do croqui no Photoshop 

3. Preparando para sobrepor as imagens 

4. Ajustando as fotos 

5. Salvando as amostras 

 

 

1. COMO PASSAR CROQUI DO AUTOCAD PARA O PHOTOSHOP 

 

Ensina-se aqui o processo de obtenção do croqui com formato de imagem JPEG, o qual será 

utilizado como base dentro do Photoshop. 

 

a) Ctrl + P ou   

b) Printer/Plotter --> dwg to jpeg 

c) Plot offset --> center the plot 

d) What to plot -> window 

e) Delimitar a janela enquadrando o desenho do croqui (2 pontas diagonais entre si) 



58 

 

f) Sua tela deverá ficar parecida com a figura abaixo. 

 

g) Ok -> salvar 

 

2. COMO ABRIR E AUMENTAR O TAMANHO DO CROQUI NO PHOTOSHOP 

 

Comandos básicos do Photoshop 

“Ctrl” + “D” = tirar seleção (não adianta pressionar Esc) 

“Ctrl” + “+” = aumentar o zoom 

“Ctrl” + “-” = diminuir o zoom 

 

a) File -> Open... (escolher o desenho) -> open 

b) Menu superior -> Image -> Canvas Size 
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c) Multiplicar por 10 as dimensões (sugestão, mas pode ser qualquer valor) -> ok 

d) Ctrl – (para tirar o zoom). O desenho ficou bem pequeno em relação ao fundo 

e) Selecionar o croqui 

f) Menu superior -> Edit -> Transform -> Scale 

 

 

 

g) Mudar a proporção do W e do H até centralizar na folha (no exemplo coloquei 800%). 

E apertar na seta . 
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h) File -> save 

 

3. PREPARANDO PARA SOBREPOR AS IMAGENS 

 

a) Se o croqui não estiver aberto, vá em File -> Open -> (selecione o arquivo com o croqui) 

b) Habilitar a régua: Menu superior -> View -> Ruler 

c) Criar guias para ajudar no posicionamento correto das imagens 

d) Clicar na régua e sem soltar, arrastar até a posição que se quer (isto é, nas linhas do 

croqui) 

e) Ao soltar, a linha ficará com a cor ciano.  

 

 

f) Se a guia ficou na posição errada: 
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Aumentar o zoom (Ctrl +)  

 

 

 

Clicar na move tool    

Clicar na linha e arrastar até a posição certa. 

É conselhável dar o zoom e garantir que as linhas guia estejam na posição certa, pois elas que 

servirão de base para o posicionamento das imagens. 

g) Continuar até que se obtenham linhas suficientes para o posicionamento nas imagens. 

(Colocar só a quantidade suficiente de linhas pois elas em excesso podem acabar atrapalhando. 

No exemplo, como eu tinha 3 imagens, já parti o edifício em 3 nas posições corretas para 

encaixar cada foto). 
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4. AJUSTANDO AS FOTOS 

 

a) Menu superior -> File -> Open -> Selecionar todas as fotos que irão compor a amostra 

-> Open 

 

 

 

 

 

b) Menu esquerdo  Perspective crop tool  
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c) Arrastar os quatro cantos da janela e colocar nas quinas do desenho (parte que se quer 

cortar) 

 

 

d) Dar zoom e ajustar nas extremidades. 

e) Confirmar a seleção   
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f) Selecionar a imagem (Ctrl + A) ou Menu superior  Select -> All 

g) Menu superior  Edit  Copy 

h) Abrir página (aba) com o croqui e colar a imagem 

 

 

 

i) Menu superior  Edit -> Transform -> Scale 
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j) Clicar e arrastar para a posição correta -> Clicar nas bordas com o botão direito, 

pressionar Ctrl e com o mouse e Ctrl pressionados, arrastar a borda até encontrar a guia, soltar 

quando ficar vermelha. Repetir o mesmo para todas as bordas. 

 

 

 

k) Repetir o mesmo procedimento para as outras fotos 

 

 

 

5. SALVANDO A AMOSTRA 

 

a) Juntar as camadas: Menu superior  Layer -> Merge Visible 

b) Crop tool  
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c) Salvar como JPEG 

d) Escolher alta resolução 

 

 

 

e) Como tirar as guias: View -> Clear Guides 
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f)  Agora o panorama ortogonalizado está montado e pronto para análise. 
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ANEXO B – AMOSTRAS DOS EDIFÍCIOS A1, A2 e A3 

                          

             

Figura B.1 – Edifício A1 – Prumada leste (parte 1) 
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Figura B.2 – Edifício A1 – Prumada leste (parte 2) 

            

Figura B.3 – Edifício A1 – Prumada oeste (parte 1) 
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Figura B.4 – Edifício A1 – Prumada oeste (parte 2) 
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              Figura B.5 – Edifício A1 – Empena norte                             Figura B.6 – Edifício A1 – Empena sul 
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Figura B.7 – Edifício A2 – Prumada leste 
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Figura B.8 – Edifício A2 – Prumada oeste 
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              Figura B.9 – Edifício A2 – Empena norte                              Figura B.10 -Edifício A2 – Empena sul 
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Figura B. 11 – Edifício A3 – Prumada leste 
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Figura B. 12 – Edifício A3 – Prumada oeste 
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               Figura B.13 – Edifício A3 – Empena norte                                           Figura B.14 – Edifício A3 – Empena sul 

 


